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General Instructions: 

1. This question paper consists of 39 questions in 5 sections. 

2. All questions are compulsory. However, an internal choice is provided in some questions. A 

student is expected to attempt only one of these questions. 

3. Section A consists of 20 objective type questions carrying 1 

mark each.  

4. Section B consists of 6 Very Short questions carrying 02 marks each. Answers to these 

questions should be in the range of 30 to 50 words.  

5. Section C consists of 7 Short Answer type questions carrying 03 marks each. Answers to 

these questions should be in the range of 50 to 80 words.  

6. Section D consists of 3 Long Answer type questions carrying 05 marks each. Answers to 

these questions should be in the range of 80 to 120 words.  

7. Section E consists of 3 source-based/case-based units of assessment of 04 marks each with 

sub-parts.  

 Section-A 

 

1.Which of the following phenomena always results in the cooling effect?     (a) Condensation                                                 

(b) Evaporation     (c) Sublimation                                                    (d) None of these 

2.At  Which of the following temperature water changes to vapour state ?                         

       (a) 273k                         (b) 283k                           (c) 373k                                 (d) 383k 

3.Which of the following is the heterogeneous mixture? 

     (a) Salt in water                                                   (b) water in alcohol 

     (c) sugar in water                                                 (d) water in oil  

4.In the tincture of iodine, find the solute and solvent? 

     (a) alcohol is the solute and iodine is the solvent 

     (b) iodine is the solute and alcohol is the solvent 

     (c) any component can be considered as solute or solvent 

     (d) tincture of iodine is not a solution 

5.When no more solute can be dissolved in solution at a given temperature is called………. 

Solution. 

    a) Homogenous               b) Heterogeneous                         c) Saturated              d) Unsaturated 

 

6.Symbol of sodium 

   a) Na                                b) So                                             c) S                           d) No 

 



7.A sample of NH3 molecule irrespective of source contains 82.35% Nitrogen and 17.65% of 

Hydrogen by mass. This data supports: 

  (a) Law of Conservation of Mass                                            (b) Law of Multiple Proportions 

  (c) Law of Definite Proportions                                               (d) Avogadro’s Law 

8.A plant cell wall is mainly composed of 

(a) Protein       (b)Cellulose 

    (c) Lipid       (d)Starch 

9.The cell is not applied for 

(a) Algae 

(b) Bacteria 

(c) Virus 

(d) Fungi  

10. Which of the following is connective tissue? 

(a) Ligament 

(b) Tendon 

(c) Blood 

(d) All of the above 

11. Using fertilizers in farming is an example of 

(a) No cost production 

(b) Low cost production 

(c) High cost production 

(d) None of these 

12.The management and production of fish is called 

(a) Pisciculture 

(b) Apiculture 

(c) Sericulture 

(d) Aquaculture 

 

13.Which of the following is true of two objects of different masses falling freely near the surface 

of the moon? 

a. They both have different accelerations. 

b. They have the same velocities at any instant 

c. They experience forces of the same magnitude 

d. They change their inertia 



14.The weight of an object on the Moon’s surface is 

a. 1/3 rd of the weight on Earth 

b. 1/5 rd of the weight on Earth 

c. 1/6th of the weight on Earth 

d. 1/2 nd of the weight on Earth 

15. Weedicides are used to kill.. 

(a) Pests 

(b) Insects 

(c) Unwanted plants 

(d) all of the above 

16. Apiculture is a technique used for cultivating 

(a) fish 

(b) buffalo 

(c) bees 

(d) chicken 

ASSERTION-REASONS (Q.NO. 17  to 20) 

Directions: i) Both A and R are true and R is the correct explanation of the assertion. 

ii) Both A and R are true but R is not the correct explanation of the assertion. 

iii) A is true but R is false.  

iv) A is false but R is true.  

15.Assertion: The valency of aluminium is 3 and oxygen is 2. Reason: The chemical formula of 

aluminium oxide is Al3O2. 

16. Assertion-Our natural resources are damaged due to human activities. 

Reason-due to the revolution natural resources are getting used more intensively. 

17.Assertion : A man is sitting in a boat which floats on a pond. If the man drinks some water from 

the pond, the level of water in the pond will decrease. Reason : The weight of the liquid 

displaced by the body is greater than the weight of the body. 

18.Assertion : Parenchyma cells help in storage of food. 

Reason : Parenchyma cells are the main seats of photosynthesis. 

Section-B 

Question No. 21 to 26 are very short answer questions 

21.How does evaporation cause cooling?  

22.What is manure? 

23.what are meristematic tissues? mention its two types. 

24.Prove that if a body is thrown vertically upward, the time of ascent is equal to the time of 

descent. 

25.On the earth, a stone is thrown from a height in a direction parallel to the earth’s surface while 

another stone is simultaneously dropped from the same height. Which stone would reach the 

ground first and why? 

26.what is the role of mitochondria in a cell? list its features. 

Section-C  

Question No. 27 to 33 are short answer questions 



27.Give reason for the following 

i)on increasing the wind speed the rate of evaporation increases?  

ii)How does the water kept in an earthen pot (matka) become cool during summer?  

28.During an experiment the students were asked to prepare a 10% (Mass/Mass) solution of sugar 

in water. Ramesh dissolved 10 g of sugar in 100 g of water while Sarika prepared it by dissolving 

10 g of sugar in water to make 100 g of the solution. (a) Are the two solutions of the same 

concentration? (b) Compare the mass % of the two solutions. 

29. Xylem and Phloem are two vascular tissues present in plants. mention their function and 

components. 

30. Differentiate between manure and fertilizer. 

31.Suppose the mass of the earth somehow increases by 10% without any change in its size. What 

would happen to your weight? Suppose the radius of the earth becomes twice of its present radius 

without any change in its mass, what will happen to your weight? 

32.On the moon’s surface, the acceleration due to gravity is 1.67 ms-2. If the radius of the moon is 

1.74 × 106 m, calculate the mass of the moon. (G = 6.67 × 1011 Nm2kg-2) 

33. i. State the law of conservation of momentum. 

ii. A man throws a ball of mass 0.4 kg vertically upwards with a velocity of 15 m/s. What will be 

its momentum at max height? 

 

                                                                          Section-D 

Question No. 34 to 36 are long answer questions. 

34.I)  Write the chemical formulae of the following. 

a. Magnesium chloride        b. calcium oxide              c. Aluminium chloride 

     II) Calculate the molar mass of the following substances. 

a. C2H2                                 b.   HNO3                                                                           (3+2) 

35.I) Draw diagram of a prokaryotic cell. 

   II) Differentiate between prokaryotes and eukaryotes 

   III) Name the organelle of cell which is also known as “Suicidal bag”. 

36.   (i) Define momentum. Write its SI unit. 

       (ii) How much momentum will an object of mass 10 kg transfer to the floor if it falls from a    

             height of 5 m? (g = 10 m/s2) 

    (iii) Explain how a karate player can break a pile of tiles with a single blow of his hand (1+2+2)                                                                        

 

                                                                         Section - E 

Question No. 37 to 39 are case-based/data -based questions with 2 to 3 short sub-parts. Internal 

choice is provided in one of these sub-parts. 

 

37.Anything dissolved in a solution is referred to as a solute. In a fluid solution, the amount of 

solvent always outweighs the amount of solute. In a salt solution ,Salt is a solute because it 

dissolves in water. Examples of solutes include sugar, dissolved carbon dioxide, oxygen, water 

vapour, carbon dioxide, argon, etc.                                                                                         

Solvent refers to the component of a solution that is most prevalent. It is the fluid in which the 

solute has been dissolved. Typically, a solvent is a liquid. The Latin term solv, which means “to 



loosen or untie,” is the source of the English word “solvent. Examples of the solvent include water, 

ethanol, methanol, acetone, tetrachloroethylene, toluene, methyl acetate, and ethyl acetate. 

Solution can be saturated or unsaturated, depending upon the solubility. 

1.  

1.i. What is the difference between saturated solution and unsaturated solution ? 

1.ii. If 20 g salt is dissolved in 80g solvent. Find out the mass of solution. 

1.iii. Define solubility                                                                                                                      

(2+1+1) 

                    OR 

    Why is water a universal solvent ?                                         

 

38.Different crops require different climatic conditions, temperature and photoperiods for their 

growth and completion of their life cycle. Photoperiods are related to the duration of sunlight. 

Growth of plants and flowering are dependent on sunlight. As we all know, plants manufacture 

their food in sunlight by the process of photosynthesis. There are some crops, which are grown in 

the rainy season, called the kharif season from the month of June to October, and some of the crops 

are grown in the winter season, called the Rabi season from November to April. Paddy, soyabean, 

pigeon pea, maize, cotton, green gram and black gram are kharif crops, whereas wheat, gram, peas, 

mustard, linseed are Rabi crops. 

a) Suggest any two methods used for improvement of crop yield.                       (2+1+1) 

b) Name factors affecting crop yield. 

c) What is vermicompost? 

 

39.Every object in the universe attracts every other object with a force which is proportional to the 

product of their masses (m1xm2) and inversely proportional to the square of the distance (d2) 

between them. The force is along the line joining the centers of two objects. 

  

(i) Gravitational force does not depend on 

    (a) Masses of objects 

    (b) Separation between objects 

    (c) Charges on objects 

    (d) None of these 

(ii) When mass of one body is doubled then force of gravitation will become 

    (a) Force will remain same 

    (b) Force will become double 

    (c) Force will become halved 

    (d) None of these 

(iii)What is universal gravitational constant? What is its SI unit? 

(iv) Two objects of masses 10kg and 20kg separated by distance 10m. What is gravitational    

       force between them? 
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GENERAL INSTRUCTIONS: 

1. Please read the instructions carefully. 

2. This Question Paper consists of 21 questions in two sections: Section A & Section B.  

3. Section A has Objective type questions whereas Section B contains Subjective type questions. 

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in 

the allotted (maximum) time of 2 hours. 

5.  All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions. 

ii. Marks allotted are mentioned against each question/part. 

iii. There is no negative marking. 

iv. Do as per the instructions given. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

i. This section has 16 questions. 

ii. A candidate has to do 10 questions. 

iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part. 

 

SECTION- A 

  

Q1. Answer any 4 out of the given 6 questions on Employability Skills     (1 x 4 = 4) 

 

i. The type of ROM which can have its contents erased by ultraviolet light is called ……… 

       (a) PROM                 (b) EPROM   

       (c) EEPROM     (d) Flash Memory 

ii. There is a talent contest in your town. For participating in the audition, you have to send a 

recording of a song. What would you connect to your computer to record your song? 

(a) Keyboard     (b) Microphone  

(c) Scanner     (d) Mouse 
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iii. ______________________, also known as ‘areas of improvement’ are what we do not do well and 

are not good at. 

(a) Weaknesses     (b) Strength 

(c) Interest     (d) Abilities 

 

iv. Delete E mail are stored in ___________ 

(a) Trash     (b) Spam   

(c) Inbox                (d) Draft 

 

v. Which of the following social media websites is also termed as the “SMS of the internet”?  

(a) Facebook     (b) Instagram  

(c) Twitter     (d) YouTube 

 

vi. A __________ is the interface between a user and the World Wide Web?  

(a) Web site     (b) Web Server  

(c) Web Portal     (d) Web Browser 

Q2.  Answer any 5 out of the given 6 questions        (1 x 5 = 5) 

i. Control buttons are present in the ……………. 

        (a) Navigation Panel     (b) Toolbar 

        (c) Text Panel                (d) Title Bar 

ii. Information Technology that enables the business by improving the quality of service 

is___________ 

     (a) IT     (b) ICT  

     (c) ITeS     (d) None of these 

iii. In Open Office Writer, to close an opened document, we should go to which of the following menu? 

      (a) File Menu     (b) Insert Menu   

     (c) View Menu     (d) Edit Menu 

iv. In Writer document, to replace a word Bombay with Mumbai, we should go to which of the 

following menu? 

      (a) Tools     (b) Edit    

     (c) View     (d) Language 

v. The numeric keypad has _________ columns and _________ rows. 

      (a) 4, 5      (b) 5, 6    

            (c) 5, 4     (d) 6, 5 

vi. While touch typing make use of …………..fingers. 

     (a) 10     (b) 5    

     (c) 4     (d) 2 
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Q3.  Answer any 5 out of the given 6 questions        (1 x 5 = 5) 

i. We can transfer money from one account to another account by _________ 

        (a) NEFT      (b) RTGS  

       (c) Both a & b       (d) None of these 

ii. Delete key of keyboard deletes the character at the ___________ cursor position. 

       (a) Left        (b) right  

       (c) Both (a) & (b)          (d) top 

iii. What is the shortcut key to open Navigator window in order to jump to a particular page in 

OpenOffice Writer document? 

 (a)  F7     (b) F11    

               (c) F5     (d) F4 

iv. While typing, keep your elbows at ____________________. 

(a) Left angle         (b) Right angle  

  (c) Straight           (d) Curved 

v. _____________ is the shortcut key to write the text in Superscript in OpenOffice Writer. 

         (a) Shift + Ctrl +P      (b) Shift + Ctrl +S    

(c) Shift + Ctrl +T     (d) Shift + Ctrl +R 

 

vi. In OpenOffice Writer, which of the following is the correct way to split a table? 

(a) Table > Split Table   (b) Table > Split 

  (c) Split> Table      (d) None of these 

Q4.  Answer any 5 out of the given 6 questions        (1 x 5 = 5) 

i. The Vertical ruler formats the…………… alignment of text. 

 (a) Top       (b) Right 

(c) Vertical                   (d) Horizontal 

ii. Which option allows you to save an existing file with a new name? 

 (a) Save                   (b) Save as 

(c) Save a copy        (d) All of thyese 

 

              iii. In Open Office Writer, on which toolbar do you find Check Spelling button? 

(a)  Formatting        (b) Standard 

(c) Drawing      (d) Tools 

 

iv. Which of the following toolbars has the ‘Table’ command in Writer? 
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(a) Standard toolbar        (b) Formatting toolbar 

(c) Drawing toolbar      (d) None of these 

 

v. In Rapid Typing software, statistics toolbar has buttons for ___________________. 

(a) Choosing courses        (b) Removing statistics 

(c) Customizing statistics displays  (d) All of these 

 

vi. Which of the following is a correct way to insert an image from your computer? 

(a) Insert>Picture>File         (b) Insert>Shape 

(c) Format>Picture           (d) Insert>Image 

 

Q5. Answer any 5 out of the given 6 questions        (1 x 5 = 5) 

 

i.  Which field has been benefitted from using Information Technology? 

(a) Education          (b) Health 

(c) Governance       (d) All of these 

   ii.            Typing speed of Mukesh is 45 WPM. Full form of WPM is _______________.  
                 (a) Words parts Minute         (c) Words per Master 
 

                 (b) Words per Minute           (d) None of above  

 
iii       This is a keyboard shortcut to open the spelling and Grammar dialog box. 

(a) F2      (b) F7 

(c) F5                      (d) F8 

iv     KAMAL purchased a new shop and wants to invite his friends and relatives (approximately number 

100) on inauguration ceremony. Which feature of Writer will help him to create personalized 

invitation letter for everyone? 

(a) Documentation     (b) Mail Merge 

(c) Style     (d) Template  

v. In Mail Merge, the list that contains name, addresses etc. which is used in mail merge is called 

_________________. 

(a) Data Source     (b) Common Document 

(c) Main Document    (d) None of these 

Vi-          SHIVA wants to divide a table into two. Which of the following option will help her?  

                (a) Table -> Split Table      (c) Format -> Table -> Merge Table 

              (b) Table -> Merge Table                                      (d) Format -> Table -> Split Table  
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SECTION B 

Answer any 3 out of the given 5 questions on Employability Skills     (2 x 3 = 6) 

Answer each question in 20 – 30 words. 

Q6. What is the difference between?  

(1)  ALU and CU.              (2) Primary and Secondary memory 

Q7. What do you mean by Multithreading and Multi-Tasking Operating System? 

Q8. What is web page? Explain types of web pages in brief. 

Q9. Explain the following devices in brief: Thumb drive, Stylus. 

Q10. Define - (A) Screensaver           (B)   Peripheral devices   

 

Answer any 4 out of the given 6 questions in 20 – 30 words each     (2 x 4 = 8) 

Q11. Write Difference between Main Document and Data Source? 

Q12. What is BPO? Mention any four BPO services. 

Q13. What are the different ways of inserting a table in OpenOffice Writer document? 

Q14.  Define typing accuracy and typing error. 

Q15. What do you understand by Thesaurus?   

Q16. How do you Split a table in open office writer? 

 

Answer any 3 out of the given 5 questions in 50– 80 words each             (4 x 3 = 12) 

Q17.a) Write the steps to print a document in OpenOffice Writer. 

        b) What is mail merge? Write any three benefits of mail merge?             (2+2) 

Q18. a) Hotel ‘Crown Plaza’ is hosting a seminar which emphasizes on the growing needs of hospitality 

business. This seminar will be attended only by male owners of different hotels. But by mistake, the 

receptionist of the hotel typed title ‘Mrs’ in place of ‘Mr’ before the names of all the invitees. What method 

will you suggest to the receptionist to rectify the mistake without wasting much time? 

b) Radhika is an office assistant and handles all the correspondence work of the company. In the current 

month her company has made five new clients. Where will she add the contact details of these new clients 

while using the mail merge feature? 

c) Raghav has written an essay on ‘Festivals of India’ in OpenOffice Writer. She has discussed Christmas 

before Diwali. Her teacher has asked her to change the order of the paragraphs. Suggest her a  method to 

move paragraph and paste it at the end by using shortcut keys. 
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d) The teacher has asked Swati to create and save a new document in OpenOffice Writer using the shortcut 

key combination. Help her in finishing this task.                

             (1+1+1+1) 

Q19. Sharmishtha is preparing a list of clothes which have to be bought for Durga Puja for her entire 

family.she has a rough list with data,help her organize the rough information below in tabular form 

Father-2 shirts, 2 trousers 

Mother – 3 Sarees 

Sharmistha -2 jeans, 3 tops                   (4) 

 

Q20.  a) Ravi needs to prepare an article on Indian Cinema. He typed 150 words per 5 minutes with errors in   

10 words. Find the Gross speed, Net speed and Accuracy percentage of typing. 

b)  Define –  

(a) Guide key        (b) Home key            (c) Find and Replace   (d)   Home Row Key   

                                                                                                                                                     

(2+2) 

Q21. a) Distinguish between main document and data source. 

         b) What is the difference between Super script and subscript?            (2+2) 
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GENERAL INSTRUCTIONS: 

1. All questions are compulsory. 

2. Adhere to the prescribed word limit. 

                                    SECTION – A (READING)             (20 Marks) 

Q1. READ THE FOLLOWING PASSAGE CAREFULLY:        (10 marks) 

Driving etiquette is a civilized driving behavior, comprising observance of rules and 

propriety. Certain statutory obligations have to be observed. While driving a vehicle, it 

is absolutely essential that all documents connected with the ownership of the vehicle, 

driving license, pollution - free certificate in original etc. are kept in the car. They have 

to be produced on demand by the competent authority. 

When a person driving a vehicle is still a learner, an 'L' broad should be prominently 

displayed. To caution pedestrians or a slow moving vehicle in front of us, sounding the 

horn is essential. We are bound to do it legally as well but we should not honk 

unnecessarily, creating sound pollution. 

Basic human dignity is more important than strict observance of rules. At crossroads, 

those who come from our right always have precedence. We should give hand signals 

for those who follow us, particularly when we slow down, take a sudden turn or overtake 

a vehicle. Never overtake a vehicle from the wrong side even if there is space. When 

another driver makes a mistake, try to correct him if time permits, instead of abusing 

him or threatening him with dire consequences. When you make a mistake, admit it 

gracefully and apologize for it if possible. When we cause an accident, instead of 

escaping we should find out from the victim whether we caused any injury and whether 

any medical assistance is required. If necessary, we should take the injured person to the 

hospital and inform the police. 

The sign of good driving is to create a feeling of safety among other passengers. Abrupt 

braking, smoking or speaking over the mobile phone makes them insecure. Drunken 

driving is illegal and immoral. Under the influence of liquor the driver does not know 

what he is doing. When you stop at a traffic signal, stop the engine as otherwise it leads 

to atmospheric pollution. 



Powerful lights cause harm to those who come from the opposite side. Dipping and 

dimming lights should be a habit with us. Similarly, playing the music system at high 

volume is irritating to others. We must be sensitive to others' needs. Keeping to our lane 

is not only convenient and safe for us but is also a legal compulsion. Finally, politeness 

on the roads does not cost us anything; it only makes driving a pleasure. 

So let us all be polite even as we observe the rules of the road. 

1. On the basis of your reading of the passage, answer the following questions. 

(i) What is driving etiquette?                                                                                           2 

(ii) Write some examples of etiquette to be followed while driving.                              2 

(iii) One sign of good driving is ______________________________.                        1 

(iv) ____________________documents should be kept in the vehicle while driving?  1 

 

(v) Find a word from Para 1 which is a synonym of  ̳protocol'. 

(a) Etiquette                               (b) Competent 

(c) Obligations                           (d) Behavior 

 

(vi) Find a word from the passage which is synonym of  ̳mandatory‘. 

(a) Essential                                (b) Possible 

(c) Statutory                                (d) Inform 

 

(vii) Find a word from Para 1 which is the synonym of  ̳concerned‘. 

(a) Insecure                                  (b) Competent 

(c) Immoral                                  (d) Legal 

 

(viii) Find a word from the passage which means  ̳sudden and unexpected‘. 

(a) Abrupt                                    (b) Essential 

(c) Injury                                      (d) Assistance 

 

Q2. Read the passage and answer the following questions:  (10 marks) 



INFECTIOUS DISEASE 

1. Within the next 25 years, AIDS is set to join heart diseases and stroke as the top three 

causes of death worldwide. Currently ranked fourth behind heart diseases, stroke and 
respiratory infections, AIDS is set to become No. 3. It accounts for about 2.8 million 

deaths every year. But researchers estimate a total of nearly 120 million people who 

could die in the next 25 years. Overall, researchers predict that in the next three decades, 

the causes of global mortality will be strikingly similar worldwide—apart from the 
prevalence of AIDS in poorer countries. Most people will be dying at an older age of 

non-infectious diseases like cardiovascular diseases, stroke and cancer. 

 
2. The World Health Organization estimates that a total of at least 117 million people 

will die from AIDS from 2006 to 2030. In an optimistic future projection, if new HIV 

infections are curbed and access to life-prolonging anti-retroviral is increased, 89 million 

people will die from the disease. “What happens in the future depends very much on 
what the international community does now,” said Mathers, who is a doctor. These 

marked differences should spark changes in current approaches to controlling AIDS 

now, say some experts. 

 

3. “It will be increasingly hard to sustain treatment programs unless we can turn off the 

tap of new HIV infections,” said Richard Hays. “These AIDS numbers point to a need 

to do more in prevention.” Simply focusing on treatment or politically uncontroversial 
prevention methods will not suffice. “You can’t put all your eggs in the abstinence 

basket,” said Hays. “We need a menu of strategies for real people,” he said, adding that 

condom distribution as well as new methods, such as a vaccine, are needed. 
 

4. Mathers and Loncar analysed data from more than 100 countries. The authors looked 

at the links between mortality trends and income per capita, as well as factors including 

education levels and tobacco use. Their research also used UN estimates for projected 
AIDS infection rates and the World Bank’s numbers for future income per capita. They 

predicted the future causes of deaths and diseases. 

 
5. This is an important contribution that will help us determine the priorities in public 

health,” said Majid Ezzati, a doctor and an associate professor of international health at 

Harvard University, who was not connected to the paper. While it may be possible to 

avert some of the impending damage from HIV/AIDS, Mathers says that other 
predictions are unlikely to vary significantly. As populations age, he explains, they are 

naturally more susceptible to illnesses like cancer and heart diseases than infectious 

diseases-even in the developing world. Life expectancy is expected to increase 

worldwide, with the highest projected life expectancy in 2030 to be in Japanese women 
at 88.5 years. 

 

1. Choose the correct option: 



(a) Which is an infectious disease? 

(i) Cancer                                             (ii) Heart disease 

(iii) AIDS                                            (iv) Stroke 
 

(b) When people age, they are more susceptible to cancer and heart diseases than to 

……… diseases. 

(i) skin                                                  (ii) infectious 
(iii) brain                                              (iv) stomach 

 

(c) What is the projected life expectancy for Japanese women in 2030? 
(i) 80 years                                          (ii) 85 years 

(iii) 85.5 years                                    (iv) 88.5 years 

 

(d) At which university is Majit Ezzabi teaching? 
 

(e) In the sentence As populations age ……… 

(i) population of the country               (ii) old people 
(iii) people of the country/city            (iv) age of the people 

 

(f) What is a synonym for the word ‘abstinence’? 

(i) absent                                              (ii) self-interest 
(iii) self-control                                   (iv) repentance 

 

(g) What does ‘AIDS’ stand for ______________ 

 

(h) ‘Putting all your eggs in one basket’—what does this refer to? 

 

(i) What should be done to control HIV infection, according to Hays?  

_____________________________. 

 

(j) What are the two causes of death worldwide? 

1. _______________________            2. _____________________ 

 

                                            SECTION – B (WRITING) 10M                                                

Q3.You are Soumya/ Saurav of class ix. You always wanted to be the monitor of your 

section but never got a chance.But this time you were chosen for the same. Express 

your emotion in about 120 – 150 words.          (5 marks) 

                                                                  OR 

Write a descriptive paragraph about the city Jaipur. 

Q4. Write a story in about 125– 150 words on the basis of hints provided:  5M 



A shopkeeper bought milk, ghee, butter, khoya from a farmer… sold them to the 

customers… the farmer would buy a lot of provisions from the shopkeeper in return… 

this went on for years… one day the shopkeeper just casually checked the weight of 

farmer’s supplies… to his shock, each one kg packet weighed only 900 grams… he was 

furious … took up the matter with the farmer… farmer replied “I don’t have weighing 

scales at home. I use one of the packets of the stuff I buy from you as a standard thinking 

it must be one kg.” … the shopkeeper felt ashamed. 

                                             SECTION – C GRAMMAR 

Q5. Attempt  the following questions. 10M 

i. Fill in the blank by choosing the correct option to complete the magazine article. The 

thief and the eye-witness _________________. 

(a) has escaped                                     (b) has been escaping 

(c) was escaping                                   (d) have escaped 

ii. Select the correct option to fill in the blank for the given line to complete an online 

update. 

During the college days, I _____ beat them all in the race! 

(a) could                                       (b) should 

(c) can                                           (d) might 

iii. Complete the notice by filling in the blank with the correct option: 

The swimming pool _____ at 6 a.m. daily. 

(a) open                                         (b) is opening 

(c) opened                                     (d) opens 

 

iv. Fill in the blank by using the correct form of the word in the bracket. 

The forecast _____ (mention) a quiet start to the day with a spell of rain to come later 

on in the afternoon. 

 

v. All of the CDs even the scratched one,______________in the case.(are,is) 

vi. Identify the error in the given sentence from an article and supply the correction. 

Overeating is one of the more wonderful practices among those who think that they 

can afford it. Use the given format for your response. 



 

Error Correction 

  

 

vii. Complete the given sentence, by filling in the blank with the correct option: 

Many researchers _____ how small business owners can be successful beyond the 

initial few years in business. 

(a) have studied                                    (b) has studied 

(c) had studied                                      (d) is studied 

 

viii. Fill in the blank by choosing the correct option to complete the sentence. 

It was a long day. You _____ be hungry. 

(a) must                                                (b) might 

(c) need to                                            (d) should 

 

ix. Fill in the blank by choosing the correct option, to complete the sentence. 

The news I heard just now is so strange that you _____ not believe it. 

(a) will                                                   (b) could 

(c) might                                                 (d) None of these 

 

x. Identify the error in the given description about Sachin Tendulkar and supply the 

correction. 

Sachin Tendulkar is the best cricketer in India. He has played for many than twenty 

years for the Country. Use the given format for your response.   

 

Error Correction 

  

                         



                                   SECTION – D (LITERATURE) (40 marks) 

Q8. Read the extract and answer the following questions:        5m 

I will rise and go now, for always night and day                                                                        

I hear the lake water lapping with low sounds by the shore;                                              

while I stand on the roadway, or on the pavement grey,                                                                

I hear it in the deep heart’s core. 

(i)           What does the poet hear in his deep heart’s core? 

(ii)           What type of place is Innisfree? 

(iii) How does the poet contrast it with where he now stands? 

(iv) Which word means the same as ‘coast’? 

(v) Name the poem and the poet of the above extract. 

                              OR 

 Read the extract and answer the following questions that follow.  

Wind, come softly. 

Don’t break the shutters of the windows. 

Don’t scatter the papers. 

Don’t throw down the books on the shelf. 

There, look what you did — you threw them all down. 

You tore the pages of the books. 

You brought rain again. 

1.Name the poetic devices used in the1st,2nd,3rd above extract. 

I) Anaphora              ii) simile          iii) metaphor            iv) personification 

2.Whom does the poet appeal ?  _____________________- 

3.Who tore the pages of the books? 

4.Name the poet and the poet.                                                                                                             5.What has 

the wind done? 

Q10. Read the passage and answer the following question. 5M 

Einstein hated the schools regimentation, and often 



Clashed with his teachers. At the age of 15, Einstein felt 

So stifled there that he left the school for good. 

1. Why Einstein used to hate his school? 

2. Who is the writer of the above extract? 

3. How did Einstein behave with his teachers? 

4. Why did Einstein decide to leave the school for good? 

5. Give the synonym of the word CLASHED. 

 

 

                                                      OR 

Sit up,” he ordered, “and hold out your hands. You must be taught once and for all not 

to touch what does not belong to you”. 

(a) Who has to be taught a lesson ? 

(b) The person has to be taught a lesson because ‘ 

(c) To teach her a lesson, the speaker _________ 

1. used a ruler to hit her on the palms 

2. beat her with a stick 

3. locked her in her room 

4. scolded her 

 

(d) What is the impact of the punishment on the receiver ? 

(e) What does it reflect about the speaker and the receiver's relationship? Strictness      

and_________ 

 

Q9. Answer the following questions in about 30 – 40 words:ANY FOUR (3x4=12) 

(i)What things about the book did she find strange? 

(ii)Who rediscovered or redesigned pungi? How? 

(iii)How did Einstein react to the bombing of Hiroshima and Nagasaki? 

(iv)What kind of a girl Evelyn is? What is the secret of her success? 

(v)Why did the father come to Kezia’s room every morning? How did she respond? 



  

Q 10. Answer the following questions in about 30 – 40 words:ANY TWO (2x3=6) 

i) What did the child ask his parents for? Why didn’t he boldly request for all his 

wished things? 

ii) Why did the king order the execution of the merchent? 

iii) How does Toto take a bath? Where has he learnt to do this?     

Q11. Answer the following questions in about 120- 150 words.               6M 

Mirror plays a significant role in our daily life, describe its role in the story “The Snake 

And The Mirror” 

                                                                  OR 

What are the main features of mechanical teachers and the school rooms that Margie 

and Tommy have in the story? 

Q11. Answer the following questions in about 120- 150 words.                  6M 

What made the leaden heart of the prince and the dead bird to most precious things in 

the city, in the eyes of God? 

                                                                 OR 

‘Fools can be dangerous people’. How does the story prove it?  



                   संत पी बी एन स्कूल 

                      आदर्श प्रश्न पत्र  

                           कक्षा नवम 

                                  ववषय ह दंी 
 अ० अंक -80                                                   समय -3 घण्टे                                                                                           

सामान्य ननदेर् 

* इस प्रश्न में चार खंड  ै खंड क, , ग और घ 

* खड़ क में वस्तुपरक, खंड ख में व्याव ाररक व्याकरण, खंड ग में पाठ्य पुस्तक एवं पूरक पाठ्य पुस्तक 
और खंड घ  में रचनात्मक लेखन से प्रश्न पूछे गए  ैं । 

* हदए गए ननदेर्ों का पालन करते  ुए प्रश्नों के उत्तर दें । 

* र्ब्द सीमा का ध्यान रखें । 

प्रश्न-1  ननम्नललखखत गदयांर् को ध्यानपूवशक पढ़कर इसके आधार पर सवाशधधक उपयुक्त उत्तर वाले ववकल्प 
चुनकर ललखखए –          (7) 

कुसंग का ज्वर सबसे भयानक  ोता  ै । य  केवल नीनत एवं सदववृत्त का  ी नार् न ीं करती बल्ल्क 
बुदधध का भी क्षय करता   ै । यहद युवा पुरुष की संगनत बुरी  ोगी, तो व  उसके पैरों में बंधी चक्की के 
समान  ोगी जो उसे हदन-हदन अवननत के गड्ढे में धगराती जायेगी । और अच्छी  ोगी तो स ारा देने वाली 
बा ु के समान  ोगी जो उसे ननरंतर उन्ननत की ओर उठाएगी । 

     इंग्लैंड के एक ववदवान को युवावस्था में राज दरबार में जग  न ीं लमली । इस पर ल्जंदगी भर अपने 
भाग्य को सरा ता र ा । ब ुत से लोग इसे अपना दभुाशग्य समझते पर व  अच्छी तर  जानता था कक 
व ां व  बुरे लोगों की संगनत में पड़ता जो उसके आध्याल्त्मक उन्ननत में बाधक  ोते । ब ुत से लोग ऐसे 
 ोते  ैं ल्जनके घड़ी भर के साथ से बुदधध भ्रष्ट  ो जाती  ैं क्योंकक उतने  ी बीच में ऐसी बातें क ी जाती 
 ै जो कानों में न ीं पड़नी चाह ए । धचत्त पर ऐसे प्रभाव पड़ते  ैं ल्जनसे उनकी पववत्रता का नार्  ोता  ै । 
बुराई अटल भाव धारण करके बैठती  ै । बुरी बातें धारणा में अधधक हदन तक हटकती  ै । सभी लोग 
जानते  ैं कक भददे व फू ड़ गीत ल्जतनी जल्दी ध्यान पर चढ़ते  ैं, उतनी जल्दी कोई गंभीर या अच्छी 
बात न ीं । एक बार एक लमत्र ने मुझसे क ा कक उसके लड़कपन में क ीं से एक बुरी क ावत सुनाई थी  
ल्जसका ध्यान लाख चेष्टा के बाद भी बार-बार आता  ै ल्जन भावनाओं को  म दरू करना चा ते  ैं, वे 



बार-बार हृदय में उठती  ै और बेधती  ै । अतः तमु पूरी चौकसी रखो, ऐसे लोगों को साथी न बनाओ जो 
अश्लील, अपववत्र बातों से तुम् ें  ंसाना चा ते  ैं । 

(1) कुसंग से क्या प्रभाव पड़ता  ै ?        (1) 
कथन पढ़कर स ी ववकल्प का चयन कील्जए - 
1 )  नीनत सदववृत्त का क्षय  ोता  ै । 
2) इन तीनों में वदृधध  ोती  ै । 
3 ) कोई प्रभाव न ीं पड़ता । 

4 ) लमत्रों से उसकी मान बढ़ता  ै । 

     ववकल्प  

     क)कथन 1 स ी  ै 

    ख) कथन । और 2 स ी  ै 

     ग) कथन 2 व 3 स ी  ै 

घ) कथन 3 बार 4 स ी  ै 

(2)युवा पुरुष की बुरी संगनत ककसके समान  ै ?          (1)  

  क) धन अधधक प्राप्त  ोगा । 

  ख) व  उन्ननत के लर्खर पर बैठ जाएगा । 

  ग) व  पैरों में बंधी चक्की के समान  ै । 

  घ) लोग उसका लो ा करने लगेंगे । 

(3) ननम्नललखखत कथनों पर ववचार कील्जए –                (1)  

    क) कुसंगनत एक ज्वार के समान  ोती  ै । 

    ख) कुसंग से बुदधध भ्रष्ट  ो जाती  ै । 

    ग) कुसंगनत में व्यल्क्त चोकसश र ता  ै । 

    घ) इसे आध्याल्त्मक ववकास  ोता  ै । 

 



उपयुशक्त कथनों में से कौन से कथन स ी  ै ? 

 1) केवल (क) (2)केवल (क) और (ख) (3) केवल (ग) ( 4 ) केवल (घ) 

(4) बुरी संगनत का युवा ववदवान के आध्याल्त्मक उन्ननत पर क्या प्रभाव पड़ता  ै ?       (2) 

 (5)  में कैसा लमत्र बनाना  ै ?                                              (2) 

 

 

                       

 

(2) प्रकृनत  मारे जीवन में एक म त्वपूणश भूलमका ननभाती  ै। पेड़-पौधे, नदी, प ाड़, और जंगल     
सभी लमलकर इस धरती को सुंदर और जीवनदानयनी बनाते  ैं। पडे़  में ऑक्सीजन प्रदान करते  ैं, 
जो  मारे जीववत र ने के ललए आवश्यक  ै। नदी का पानी  मारे पीने और खेती करने के ललए 
म त्वपूणश  ै। प ाड़  में खननज पदाथश और प्राकृनतक संसाधन प्रदान करते  ैं। जंगलों में कई प्रकार 
के जीव-जंतु र ते  ैं, जो पयाशवरण संतुलन बनाए रखने में स ायक  ोते  ैं। यहद  म प्रकृनत की 
सुरक्षा का ध्यान न ीं रखेंगे, तो इसका प्रभाव  मारे जीवन पर ब ुत नकारात्मक  ो सकता  ै।  में 
पेड़ लगाने चाह ए, जल का संरक्षण करना चाह ए, और जंगलों की कटाई को रोकना चाह ए ताकक 
 म आने वाली पीहढ़यों को एक सुरक्षक्षत और स्वस्थ वातावरण दे सकें ।                  (7) 

 

1) कथन और कारण पढ़ कर ववकल्प चुननये  

 

1. कथन: पेड़-पौधे  में ऑक्सीजन प्रदान करते  ैं।           (1) 

   कारण: पेड़-पौधों की जड़ें पानी को खींचकर वातावरण में छोड़ती  ैं। 

   - (A) कथन और कारण दोनों स ी  ैं, और कारण कथन की स ी व्याख्या  ै। 

   - (B) कथन और कारण दोनों स ी  ैं, लेककन कारण कथन की स ी व्याख्या न ीं  ै। 

   - (C) कथन स ी  ै, लेककन कारण गलत  ै। 

   - (D) कथन गलत  ै, लेककन कारण स ी  ै। 



 

  2 .जंगलों की कटाई से पयाशवरण संतुलन बबगड़ सकता  ै। क्या य  -         (1) 

   क ) कुछ कुछ स ी  ै 

 ख) गलत  ै 

 ग) गलत कथन  ै मनुष्य के र ने के ललए घरों की आवश्यकता  ोती  ै इसललए पेड़ काटे जाते  ैं । 

 घ) स ी कथन  ै पयाशवरण में संतुलन बनाए रखने  ेतु वकृ्षों की कटाई की रोकथाम करनी  . और नये 
पौधारोपण करना चाह ए । 

 3 .जंगलों में कौन पयाशवरण के संतुलन में म त्वपूणश भूलमका ननभाते  ैं ?         (1) 

क) पेड़ पौधे 

ख)  जीव जन्द ु

ग) जल 

घ)  भुलम 

 4.  इस धरती को सुंदर और जीवनदानयनी बनाने के ललए क्या – क्या आवश्यक  ै ?     (2) 

 5.  नव पीहढ़यों को सुरक्षक्षत रखने के ललए  में ककन-ककन चीजों को संरक्षक्षत एवं स्वस््य रखने की 
आवश्यकता  ै ?               (2) 

                                                      व्यावा ाररक वातावरण 

प्रश्न -3 ननम्नललखखत में से ककन् ीं दो प्रश्नों के उत्तर दील्जए :-           (2) 

1) र्ब्द क्या क लाता  ै ? उदा रण सह त बताइए । 
2) पद ककसे क ते  ै ? उदा रण सह त बताए । 
3)  अववकारी र्ब्दों के भेदों के नाम ललखे। 

प्रश्न 4 ननम्नललखखत में से ककन् ीं दो प्रश्नों के उत्तर ललखखए :-        (2) 

1. चकाचौध , प्रपच र्ब्दों में उधचत स्थान पर अनुस्वार का प्रयोग करें । 

2. उडेल, आखे इन र्ब्दों में उधचत स्थान पर अनुनालसक का प्रयोग करें । 

3. वाङमय, चञ्चल इन र्ब्दों को मानक रूप में उधचत स्थान पर अनुस्वार का प्रयोग करते पुनः ललखें 
। 



प्रश्न-5 ननम्नललखखत में से ककन् ीं दो प्रश्नों के अथश के आधार पर भेद बताते  ुए उत्तर दील्जए   (2)     
             

        1 ) ईश्वर करे, तुम फलते-फूलते र ो । 

       2) फुटबॉल मैच न जाने कौन जीतेगा । 

       3 ) वा  ! तुमने तो कमाल  ी कर हदया ।  

प्रश्न -6 ननम्नललखखत में से चार प्रश्नों के उत्तर दील्जए –            (4) 

   1 ) आल ूउपसगश का प्रयोग करते  ुए दो र्ब्द ललखखए । 

  2) इक प्रत्यय का प्रयोग करते  ुए दो र्ब्द ललखखए । 

  3) अपमाननत र्ब्द में उपसगश व प्रत्यय के साथ - साथ मूल र्ब्द भी बताइए । 

  4) धचतंा में कौन सा प्रत्यय  ै ? 

  5) वव उपसगश से दो र्ब्द बनाएं । 

प्रश्न -7 ननम्नललखखत वाक्यों में से केवल तीन वाक्यों में उधचत ववराम धचन् ों का प्रयोग करते  ुए दोबारा 
ललखखए ।            (3) 

1. यहद तुम नैनीताल चलो तो मैं भी चलूूँ  
2. क्या तुमने अपना काम पूरा कर ललया 
3. वा  तुमने तो कमाल कर हदया 
4. बच्चा स्कूल न ीं जाता  ै 

प्रश्न 8 ननम्नललखखत में से केवल तीन प्रश्नों के उत्तर दील्जए ।           (3) 

1. परोपकार र्ब्द का संधध ववच्छेद कील्जए । 

2. नयन र्ब्द का संधध ववच्छेद कील्जए । 

3. परमौषध र्ब्द का संधध ववच्छेद कील्जए और संधध भेद का नाम भी बताएं। 

4. संधध की पररभाषा और उसके भेद बताइए । 

प्रश्न 9 ननम्नललखखत काव्यांर् को पढ़कर पूछे गए प्रश्नों के उत्तर के ललए स ी ववकल्प चुनकर दील्जए : -  
                 (5) 

 



रह मन धागा प्रेम का, मत तोड़ो चटकाय  

टूटे से कफर ना लमले, लमले गाूँठ परी जाए ।  

रह मन ननज मन की बबथा ,  मन  ी रखो गोय । 

सुनी अहठलै ैं  लोग सब ,  बाूँहट ना लै ैं कोय ॥ 

प्रश्न -1 र ीम दास प्रेम के धागे को कैसे तोड़ना इसे मना करते  ैं ? 

1. चटकाकर  

2. धीरे से  

3. खींच कर  

4. जोर से 

प्रश्न -2 धागे के टूटने पर क्या  ोता  ै ? 

य  लमलता न ी ं

1. लमलने पर गांठ पड़ जाती  ै 

2. क और ख दोनों 
3. कुछ न ीं 

प्रश्न -3 अपने मन की व्यथा को क ां रखना चाह ए ? 

1. मन में छुपा कर  

2. दसूरों को बता कर 

3. र्ोर मचा कर  

4. कुछ ना क  कर 

प्रश्न 4तुम् ारी व्यथा सुनकर लोगों पर क्या प्रनतकिया  ोती  ै ? 

1. वे सुनते  ैं  

2. व  तुम् ारी  ंसी उड़ाते  ैं  

3. व  दखु बांट न ीं सकते  

4. ये सभी बातें 

प्रश्न 5 र ीम की भाषा कौन सी  ै ? 



1. ब्रज 

2. अवधी 
3. ब्रज अवधी दोनों  

4. संस्कृत  

प्रश्न 10 ननम्नललखखत गदयांर् को पढ़कर पूछे गए प्रश्नों के उत्तर स ी ववकल्पों में से चुनकर दील्जए :- 
           (5) 

ह मपात अपने आप में एक तर  से बफश  के खंडो का अव्यल्स्थत ढंग से धगरना  ी था ।  में बताया गया 
कक ग्लेलर्यर के ब ने से अक्सर बफश  में  लचल  ो जाती थी, ल्जससे बड़ी-बड़ी बफश  की चट्टानें तत्काल 
धगर जाया करती थी और अन्य कारणों से भी अचानक प्रायः खतरनाक ल्स्थनत धारण कर लेती थी । सीधे 
धरातल पर दरार पड़ने का ववचार और इस दरार का ग रे – चौड़े ह म – ववदर में बदल जाने मात्र ख़्याल 
 ी ब ुत डरावना था । इससे भी ज्यादा भयानक इस बात की जानकारी थी कक  मारे संपूणश प्रवास के 
दौरान ह मपात लगभग एक दजशन आरोह यों और कुललयों को प्रनतहदन छूता र ेगा । 

प्रश्न 1 ह मपात क्या  ै ? 

1. बफश  खंडों का अव्यवल्स्थत ढंग से धगरना  

2. बफश  का धगरना  

3. ह म का पात  ोना 

 ठंडी वषश का  ोना 

प्रश्न 2 लेखखका को क्या बताया गया था ? 

1. ग्लेलर्यर का ब ना बफश  में  लचल पैदा करता  ै 

2. इससे बड़ी-बड़ी चट्टाने तत्काल धगर जाती  ैं 
3. अन्य कारण भी खतरनाक ल्स्थनत धारण कर लेते  ैं  

4. उपयुशक्त सभी 

प्रश्न-3 कौन सा खयाल डरावना था ? 

1. धरातल पर दरारें पड़ने का 
2. दरार का ह म बीदर में बदलने का 
3. 1,2 दोनो ववकल्प  

4. दोनों में से कोई न ीं 



प्रश्न 4 भयानक जानकारी क्या थी ? 

1. ह मपात एक दजशन आरोह यों और कुललयों को स्पर्श करेगा 
2. ह मपात भयंकर  ोगा  

3. य  कभी भी  ो सकता  ै  

4. अननल्श्चतता 

प्रश्न 5 य  पाठ ककसके दवारा रधचत  ै ? 

1. प्रेमचंद  

2. बछेंद्री पाल  

3. कनशल खुल्लर  

4. आरो ी 

प्रश्न -11 ननम्नललखखत में से ककन् ीं दो प्रश्नों के उत्तर 25 से 30 र्ब्दों में दील्जए ।  (3x2 =6) 

प्रश्ने 1 तुम कब जाओगे अनतधथ पाठ में लेखक ने ककस समस्या से अवगत कराया  ै ? क्या वतशमान 
समय में भी य  पाठ एक प्रतीत  ोता  ै ? 

प्रश्न 2 तनेल्जंग ने लेखखका की तारीफ में क्या क ा ? 

प्रश्न 3 .दखु मानने का भी एक अधधकार  ोता  ै हटप्पणी कील्जए । 

प्रश्न 12 ननम्नललखखत में से ककन् ीं दो प्रश्नों के उत्तर 25 से 30 र्ब्दों में दील्जए :-  (3x2 = 6 ) 

प्रश्न 1 मोती, मानुष, चुन के संदभश में पानी के म त्व को स्पष्ट कील्जए । 

प्रश्न-2  ‘ गीत अगीत ‘ कववता  के कें द्रीय भाव को ललखखए । 

प्रश्न 3 रववदास अपने पदों के दवारा  में क्या संदेर् देना चा ते  ैं? 

प्रश्न 13 ननम्नललखखत में से ककन् ीं दो प्रश्नों के उत्तर 60 र्ब्दों में दील्जए ।         (3x2 =6) 

प्रश्न । कल्लू कुम् ार का नाम उनाकोटी से ककस प्रकार जुड़ गया  ? 

प्रश्न 2 कुएं में उतरकर धचट्हठयों को ननकालना संबंधी सा लसक वणशन अपने र्ब्दों में ललखखए । 

 प्रश्न 3 धगल्लू पाठ में गुल्लू के बारे में क्या बताया गया  ै ? 



प्रश्न 14 हदए गए बबदंओुं के आधार पर ककसी एक ववषय पर 100 से 120 र्ब्दों में अनुच्छेद ललखखए  
          (6) 

1-इंटरनेट का जीवन में उपयोग 

➢ संकेत बबदं ु 

➢ इंटरनेट क्या  ै 

➢ लाभ – समय की बचत लर्क्षा में स ायक 

➢ उपयोग के सुझाव 

 

2-मेरा वप्रय ग्रंथ 

➢ वप्रय ग्रंथ का नाम एवं पररचय 

➢ ववर्ेषताए ं

➢ हृदय ग्राह्याता 
➢ शे्रष्ठ ग्रंथ 

 

3- में बढ़ती बेरोजगारी 

➢ बेरोजगारी क्या  ै ? 

➢ बेरोजगारी के प्रकार 

➢ र्ायरी और ग्रामीण बेरोजगारी में अंतर 

➢ बेरोजगारी बनने के कारण 

➢ बेरोजगारी रोकने के उपाय 

 

प्रश्न -15 आप नवीं कक्षा के छात्र छात्रा  ववनय / ववनीता  ै और छात्रावास में र ते  ैं । अपने लमत्र को 
छात्रावास में र ने का अनुभव बताते  ुए एक पत्र ललखखए ।        (6) 

   .                                                           अथवा  



आपके वप्रय लमत्र की आजकल लर्क्षा में अरुधच उत्पन्न  ो र ी  ै । ल्जसके कारण उन् ोंने आगे पढ़ाई 
करने से इनकार कर हदया  ै । अपने लमत्र को लर्क्षा का म त्व बताते  ुए कक लर्क्षा प्रत्येक मनुष्य के 
जीवन के ललए ककतनी उपयोगी  ै । एक  पत्र ललखें । 

प्रश्न 16 दो छात्रों के बीच प्रनतयोगी परीक्षाओं के ववषय में की गई चचाश को लगभग 100 र्ब्दों में संवाद 
के रूप में ललखखए ।                   (5) 

                            अथवा  

मह लाओं की सुरक्षा के ललए क्या-क्या इंतजाम करने चाह ए ? दो छात्रों के बीच में संवाद लगभग 100 
र्ब्दों में ललखें ।  

प्रश्न 17 नीचे हदए गए धचत्र का वणशन लगभग 60 र्ब्दों में कील्जए        (5) 
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St. PBN PUBLIC SCHOOL 

HALF YEARLY EXAMINATION 

CLASS IX 

MATHEMATICS 

SAMPLE PAPER 

Time - 3 hours           M.M: 80 

General Instructions:        

 Section A consists of 20 questions of 1 mark each.  

 Section B consists of 5 questions of 2 marks each. 

 Section C consists of 6 questions of 3 marks each. 

 Section D consists of 4 questions of 5 marks each. 

 Section E has 3 case based integrated units of assessment(04 marks each) with sub parts 

of the value 1, 1 and 2 marks each respectively. 

 

Section A 

1. Every rational number is  

(i) A non-real number   (iii) an integer 

(ii) A real number    (iv) a whole number 

2. The value of 0. 2 in the form 
𝑝

𝑞
, where p and q are integers and q≠0 is  

(i) 
1

5
      (iii) 

2

5
 

(ii) 
2

9
      (iv) 

1

8
 

3. Decimal expansion of 
1

7
 is  

(i) 0. 142857    (iii) 0. 142867 

(ii) 0. 142657    (iv) None of these 

4. Which of the following is not a polynomial? 

(i) 𝑥2 + √2𝑥 + 3    (iii) 6𝑥 + 4 

(ii) 𝑥3 + 3𝑥2 − 3    (iv) 𝑥2 − √2𝑥 + 6 

5. If a=7, then degree of the polynomial p(x)=(x-a)3+343 

(i) 0      (iii) 3 

(ii) 2      (iv) None of these 

6. If (x-2) is a factor of x3-3x2+k, the k= 

(i) 4      (iii) 6 

(ii) 2      (iv) 10 

7. The point (0,-7) lies 



Page No 2 of 3 
 

(i) On the X-axis    (iii) in the first quadrant 

(ii) On the Y-axis    (iv) in the fourth quadrant 

8. Number of quadrants of a Cartesian plane is 

(i) 2      (iii) 8 

(ii) 4      (iv) none of these 

9. The equation of the x-axis is of the form 

(i) x=0     (iii) x+y=0 

(ii) y=0     (iv) x=y 

10. If a point A lies in between B and C, then  

(i) BD = 
1

2
AC    (iii) AC = BC 

(ii) AC = 2BC    (iv) AB+AC = BC 

11. Angles of a triangle are in the ratio 2:4:3. The smallest angle of the triangle is 

(i) 60o     (iii) 80o 

(ii) 40o     (iv) 20o 

12. If one angle of a triangle is equal to the sum of the other two angles, then the triangle is  

(i) An isosceles triangle    (iii) an equilateral triangle 

(ii) An obtuse angled triangle  (iv) a right angled triangle. 

13. Two sides of a triangle are of lengths 5 cm and 1.5 cm. The length of the third side of the 

triangle cannot be  

(i) 3.6 cm     (iii) 3.8 cm 

(ii) 4.1 cm     (iv) 3.4 cm 

14. In a right angled ∆ABC, ∠A=90o, then 

(i) BC is longest    (iii) AB is longest 

(ii) BC is shortest    (iv) AC is longest side. 

15.  In ∆PQR, ∠𝑅 = ∠𝑃, PR = 5 cm and QR = 4 cm, then the length of PQ is 

(i) 4 cm     (iii) 2 cm 

(ii) 5 cm     (iv) 2.5 cm 

16. The base of a right triangle is 8 cm and hypotenuse is 10 cm. Its area is equal to 

(i) 48 cm2     (iii) 24 cm2 

(ii) 40 cm2     (iv) 80 cm2 

17. The perimeter of an equilateral triangle is 60 m. Its area is equal to 

(i) 20√3 m2     (iii) 15√3 m2 

(ii) 50√3 m2     (iv) 100√3 m2 

18. Check (2, 0) and (1, 1) are solutions of the equation x-2y=4. 

 

ASSERTION –REASON BASED QUESTIONS 
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In the following questions, a statement of Assertion(A) is followed by a statement of 

Reason(R).  

Choose the correct answer out out of the following choices. 

a) Both (A) and (R) are true and (R) is the correct explanation of (A). 

b) Both (A) and (R) are true and (R) is not the correct explanation of (A). 

c) (A) is true but (R) is false. 

d) (A) is false but (R) is true. 

19. Assertion(A): Everything equal to itself. 

Reason(R): Things which coincide with one another are equal to one another. 

20.  Assertion(A): The area of an isosceles triangle with base a and each of the equal sides equal 

to 13 cm is 60 cm2. 

Reason(R): The area of an isosceles triangle with base a and each equal side b is 
𝑏

4
√4𝑎2 − 𝑏2. 

 

Section B 

21.  Show that 0.3333… = 0. 3 can be expressed in the form 
𝑝

𝑞
, where p and q are integers and 

q≠0. 

22. Find the value of k, if x-1 is a factor of 4x3+3x2-4x+k. 

23. If the point (3,4) lies on the graph of the equation 3y=ax+7, find the value of a. 

24.  In the given figure, lines PQ and RS intersect  

each other at point O.If ∠𝑃𝑂𝑅: ∠𝑅𝑂𝑄 = 5: 7,  

find all the angles. 

 

 

25. Show that the angles of an equilateral triangle are 600 each. 

Section C 

26.  Represent √3.5 on the number line. 

27. What are the possible expressions for the dimensions of the cuboids whose volume are 

12ky2+8ky-20k? 

28. The taxi fare in city is as follows: For the first kilometer, the fare is Rs. 8 and for the 

subsequent distance is is Rs. 5 per km. taking the distance covered as x km and total fare as 

Rs. y, write a linear equation for this information and draw its graph. 

29.  Does Euclid’s fifth postulate imply the existence of parallel lines? Explain. 

30.  In fig. if AB || CD, ∠𝐴𝑃𝑄 = 50o and ∠𝑃𝑅𝐷 = 127o, find x and y.  
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31. Line l is the bisector of an angle ∠𝐴 and B is any point on l. 

BP and BQ are perpendiculars from A to the arms of ∠𝐴. Show 

That 

(i) ∆𝐴𝑃𝐵 ≅ ∆𝐴𝑄𝐵 

(ii) 𝐵𝑃 = 𝐵𝑄 

 

 

Section D 

32. Simplify 

(i) 163/4      (ii) 71/2.81/2      (iii) 93/2    (iv) (1/33)7 

33. Evaluate the following products without multiplying directly 

(i) 103x107             (ii) 95x96 

34. Plot the points (x, y) given in the following table on the plane, choosing suitable units of 

distance on the axes. 

x -2 -1 0 1 3 -2 

y -2 4 -2 3 -1 8 

  

35.  A triangle ABC is an isosceles triangle in which AB=AC.  

 Side BA is produced to D such that AD=AB.  

 Show that ∠𝐵𝐶𝐷 is a right angle. 

 

 

 

SECTION E 

36. Case Study I: 

A quadrilateral ABCD in which AB = 3cm, BC = 4 cm, CD = 4 cm, DA = 5cm and AC = 5cm. 

i). Find the semi perimeter of triangle ABC. 

ii). Find the semi perimeter of triangle ADC. 

iii). Find the area of quadrilateral of ABCD. 

37. Case Study II: 
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A rhombus shaped field has green grass for 18 cows to graze. If each side of the rhombus is 

30m and its longer diagonal is 48m. 

i). Find the perimeter of grass field ground. 

ii). Find the area of the grass field. 

iii). Find the area of grass field will each cow be getting? 

 

38. Case Study III:   

Anil went to buy some vegetables, he bought ‘x’ kgs. of tomato and ‘y’ kgs. of potato. 

The total cost of vegetables comes out to be of Rs. 200. Now if the cost of 1 kg of 

tomato is Rs. 50 and 1 kg of potato is Rs. 20, then answer the following questions. 

i).  If Anil bought ‘x’ kgs of tomato and 2.5 kgs. of potato, then find the value of 

‘x’. 

ii).  If Anil bought ‘2’ kgs of tomato and ‘y’ kgs of potato, then find the value of 

‘y’. 

iii).  The graph of 5x + 2y = 20 cuts x-axis at the point. 
 

……………………………………………………………………………….…..……xxx………………………………….……………………………………………………… 
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St. PBN PUBLIC SCHOOL 

HALF YEARLY EXAMINATION  

CLASS –IX 

SOCIAL SCIENCE 

(SAMPLE PAPER) 

TIME: 3 Hrs.                                                                   M.M. 80 

GENERAL INSTRUCTIONS:  

1. Answer all the questions. Some questions have internal choice. 

2. Section A questions 1 to 20 objective type questions carrying 1 mark each. 

3. Section-B very short answer type questions carrying 2 marks each. 

4. Section- C Short answer type questions carrying 3 marks each. 

5. Section-D Long answer type questions carrying 5 marks each. 

6. Section -E Case based question carrying 4 marks each. 

7. Section-F Map-based question carrying 5 marks with two parts. 

SECTION A 

Q.1 Uttarakhand, Uttar Pradesh, Bihar, West Bengal and Sikkim have common  

       Frontier with?  

a) China      c)Nepal 

b) Bhutan     d) Myanmar 

 

Q.2 Which statement is not correct? 

a) Conservatives wanted to bring change through a slow process. 

b) Liberals were in favour of the uncontrolled power of dynastic rulers. 

c) Radicals supported women’s suffragette movements. 

d) Liberals did not believe in universal adult franchise. 

 

Q.3 A landmass bounded by sea on three sides is referred to as 

a) Coast      c) Peninsula 

b) Island      d) None of these 

 

Q.4Name two headstreams of Ganga that unite at Devaprayag  

a) Alakananda and Yamuna  

b) Yamuna and Bhagirathi 

c) Alakananda and Bhagirathi 

d) Bhagirathi and Gomati  

                                   

Q.5   Some of the drawbacks of democracy are 

(a) Instability and delays 

(b) Corruption and hypocrisy 
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(c) politicians fighting among themselves 

(d) all the above

 

Q.6 Name the incident that started the Second World War. 

a) The Treaty of Versailles   c) Genocidal war 

b) Birth of the Weimar Republic             d) Germany’s attack on Poland 

 

Q.7 Which of the following titles is associated with the Russian ruler? 

a) Tsar     c) Emperor 

b) Kaisar     d) King 

 

Q.8 Who were jadidists within the Russian empire? 

a) Muslim reformers    c) Buddhist reformers 

b) Muslim workers    d) Buddhist cultivators 

 

Q. 9 Which of the following does not include election procedure? 

a) Voting     c) Booth capturing 

b) Nomination of Candidate   d) Canvassing 

 

Q.10 Which river is known as the ‘sorrow of West Bengal’? 

a) Damodar     c) Tapi 

b) Indus      d) Narmada 

 

Q.11 Whose entry strengthened the Allies in 1917? 

a) Germany      c) USA 

b) France      d) England 

 

Q.12 Who appoints the Chief Election Commissioner (CEC) in India?  

a) The Chief Justice of India   c) The Prime Minister of India  

b) The Lok Sabha Speaker    d) The President of India 

 

Q.13 Assertion (A):  The coastal rivers in the west are short. 

Reason (R): The coastal plains between the Western Ghats and the Arabian Sea are 

very narrow. 

(a) Both A and R are true and R is the correct explanation of A 

(b) Both A and R are true, but R is not the correct explanation of A. 

(c) A is true, but R is false. 

(d) A is false, but R is true. 

 

Q.14 Which of the following is a major river of Tamil Nadu? 

a) Narmada         c) Tapti 

b) Kaveri         d) Indus 
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Q.15 Which of the following guiding values of the Constitution of India means    

 people have supreme right to make decisions:   

a) Sovereign       c) Republic 

b) Secular        d) Fraternity 

 

16. Which of the following statements is incorrect? (1) 

(a) The concept of sharing of work by the family members in agriculture sector has 

reduced the hardships of unemployment in the rural sector. 

(b) The surplus labour in the rural areas has remained unemployed. 

(c) The surplus labour in the rural areas has migrated to urban areas for 

employment. 

(d) Small scale sector is a labour absorbing sector. 

 

17. The household work done by women is not recognised in the ___________ 

income. (1) 

 

18. Assertion (A): A large population has been considered a liability, rather than a 

asset now a days. 

Reason (R): Population can be turned into a productive asset by investment in 

human capital. 

(a) Both A and R are true and R is the correct explanation of A 

(b) Both A and R are true, but R is not the correct explanation of A. 

(c) A is true, but R is false. 

(d) A is false, but R is true. (1) 

 

19. What factors improve the quality of population? (1) 

(a) Literacy rate and health (b) Income of the people 

(c) Moral values (d) Family life 

 

20. Do you notice any difference between the two friends? List any one. (1) 
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SECTION -B 

Q. 21 What is party ticket? 

Q.22. What was the result of First World War for Germany? 

Q23   Why does the Brahmaputra in its Tibetan part have less silt, despite a longer 

 course? 

      Or 

         What is water divide? Give one example. 

 

Q. 24. What was Guillotine?  

SECTION –C 
 

Q.25 Discuss Lenin’s April Theses.      

OR 

Describe the events that took place on 14th July 1789 in France. 
 

Q.26 Free and fair elections are held in India. Comment. 
 

Q.27 What does ‘Apartheid’ mean? 

28. Why is educated unemployed a peculiar problem in India? 

OR 

What is the difference between market activities and non-market activities? 

 

29. Describe three main features of Sarva Shiksha Abhiyan. (3) 
 

                                           (Section- D) 

Q.30 What are the causes of river pollution? How can it be prevented?    

Or 

  Discuss the significant difference between the Himalayan and the Peninsular rivers. 

Q.31 What were the main changes brought about by the Bolsheviks immediately 

after the October Revolution? 

                                                                    Or 

    Discuss why Nazism became popular in Germany by 1930. 

Q.32 What is representative democracy? Why has it become necessary in recent 

times? 

                                                                             Or 

 “India emerged as an independent country amidst heavy turmoil.” Justify the 

statement. 

33. Explain any five effects of unemployment on the overall growth of the 

economy. 

 

OR  
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Describe different types of unemployment found in India. 

 

(SECTION -E) 

   CASE BASED TYPE QUESTIONS                    (4x3=12) 

34. Read the source given below and answer the questions that follow: 

Countries, like Japan, have invested in human resource. They did not have 

any natural resource. These countries are developed/ rich. They import the natural 

resource needed in their country. How did they become rich/ developed? They 

have invested on people, especially in the field of education and health. These 

people have made different use of other resources, like land and capital. Efficiency 

and the technology evolved by people have made these countries rich/developed. 

 

(a) Why is literacy rate high among men and less among women of India? (2) 

 

(b) Why is there a division of labour between men and women in the family? (2) 

 

 

35. Read the source given below and answer the questions that follow: 

Elections are fundamentally about political rivalry. This rivalry appears in different 

forms, the most evident being the competition among political parties. At the 

constituency level, it manifests as a contest between multiple candidates. Without 

this competition, the purpose of elections would be defeated. 

 

(i) Why are elections seen as crucial for any representative democracy? (1) 

(ii) What is meant by the term 'constituency'? (1) 

(iii) Is political competition beneficial? Provide reasons. (2) 

 

36. Read the source given below and answer the questions that follow: 

The major Himalayan rivers are the Indus, the Ganga, and the Brahmaputra. These 

rivers are long and are joined by many large and important tributaries. A river along 

with its tributaries may be called a river system. 

 

36.1 Where does the river Indus rise?       (1) 

36.2 Where does the river Brahmaputra rise?      (1) 

36.3 What is the role played by Yamuna, Ghagra and other tributaries in northern 

India?            (2) 
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(SECTION F) 

  MAP SKILL-BASED QUESTIONS (2+3=5) 

 

 

 

37 a) On an outline map of India, label the following.                                     (2) 

i) Axis power -Japan 

ii) Allied power- United Kingdom 

37 b.)  On the outline map of India locate and label any three of the following with 

suitable symbols.                      (3) 

i) Wular Lake 

ii) The strait separating Sri Lanka and India. 

iii)      Western Ghats 

 

 

 

 

 

 


	v. The numeric keypad has _________ columns and _________ rows.

